AutoCAD Civil 3D 2010
Yeni Ozellikler ve Ayarlar Tablosu

Duizenlemis oldugumuz bu kaynak AutoCAD Civil 3D 2010’un yeni 6zellikleri i¢in hazirlanmistir.

Amag, versiyon yeniliklerini daha rahat takip edebilmenizdir.

Yeni Ozellik Bashiklari

1 Kullanici Araytizi
2 Glizergah
3 AP
4 Koridor
5 Hidroloji
6 Uyumluluk
7 Kavsak
8 Etiket
9 LandXML
10 Nesne Aktarma
11 Parsel
12 Boru Sebekesi
13 Profil
14 Metraj
15 Arazi Modeli

16 Survey

Hazirlayan: Songil Bilge
Mimar, Uriin Sorumlusu
(@ PROTA
BILGISAYAR
Turan Guines Bul. 571.Cad.
No:27 Cankaya ANKARA
Tel: 0312 490 52 25

www.prota.com.tr






1 Kullanici Arayiizii

Ozellik

Aciklama

Yerlesim

Ribbon

Ribbon AutoCAD Civil 3D komutlarina
ulasmanin yeni bir yontemidir. Cizim
penceresinin lzerinde yer alan ribbon, komut
ve kontrollere tek bir noktadan erisim saglar.
Ribbon, siklikla kullanilan komutlara en kolay
erisebileceginiz sekilde organize edilmistir.

Cizimde nesneleri sectiginiz zaman, nesneye
Ozgti ribbon icerik sekmeleri gériintllenir
veya nesne secimi yapmadan istediginiz
sekmeleri goriintlleyebilirsiniz.

RIBBON komutu

Application Menu

Yeni ¢izim olustur, ag, kaydet ve AutoCAD’e

export et gibi ¢cizimle ilgili komutlara erismeyi

saglar.

Sol Ustte yer alan application menu butonu ile

Application Menu'ye erisebilirsiniz.

&v
30

Nesne ipuglari

Kolay okunabilir bir formatta nesne ile ilgili
ipuclar gelir.

Gizimde imlecinizi
nesnelerin Uzerinde
veya yakininda
gezdirin.

Toolspace ipuglari

Toolspace sekmelerinde yer alan basliklarla
ilgili bilgi verir.

Toolspace’'de
imlecinizi bashklarin
tizerinde gezdirin.

Ribbon ipuclari

Ribbon kontrolleri ile ilgili daha fazla bilgi icin
Help’e yonlendiren ipuglari gelir.

imlecinizi ribbon
kontrollerinin
tzerinde gezdirin.
Help'te ilgili sayfaya
ulagsmak icin Fr’e
basin.

Properties paletinde
gelen nesne ozellikleri

Bircok civil nesnesi icin civil 6zellikleri
AutoCAD’in Properties paletinde standart bir
formatta goruntilenir.

Ribbon: View sekmesi
> Palettes paneli »
Properties komutu

=
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Quick Properties Civil nesneleri icin Quick Properties paletini QPMODE degiskeni
gortntller.
Match Properties Civil nesneleri icin Match Properties komutu Ribbon: Home

kullanilabilir.

sekmesi > Modify
paneli » Match
Properties komutu

&

Prospector’dan nesne
secimi yapma

Cizimdeki nesneleri Toolspace’in Prospector
sekmesinden secmek icin yeni secenekler
sunar.

Toolspace Prospector
sekmesi > nesne
tizerinde sag tus »
Select secenegi

Prospector’da Data
Shortcuts klasor

Data Shortcuts klasoriine artik Active
Drawing View seciliyken de ulasabilirsiniz.

Toolspace Prospector
sekmesi > Active
Drawing View

secenegi
2 Giizergah
Ozellik Aciklama Yerlesim
Nesnelerden Create Alignment From Polyline komutunun ismi Ribbon: Home

olusturma

Create Alignment From Objects olarak
degistirilmistir. Glizergah geometrisi olarak
kullanmak Uzere artik birden fazla cizgi, yay ve
polyline secebilirsiniz.

sekmesi > Create
Design paneli >
Alignment » Create
Alignment From
Objects komutu
23

R
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Glizergahlar icin yeni
Tip ozelligi

Tum guzergahlar icin artik Tip 6zelligi var. Tiple
ilgili secenekler: Centerline, Offset,
Miscellaneous ve Curb Return.

Guzergah olusturma diyalog kutulari glizergah
tipini belirleme ile ilgili bir kontrol icerir. Eski
versiyon cizimlerden gelen tim glizergahlara
Centerline tipi atanr.

Toolspace Prospector agacinda, glizergahlar
tiplere gore organize edilmistir.

Guizergah olusturma
diyalog kutulari

Alignment Properties
diyalog kutusu
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Yeni Alignment
Properties

Alignment Properties diyalog kutusuna
maskeleme ile ilgili yeni bir sekme eklenmistir.

Maskeleme 6zelligi glizergah lzerinde guzergah
geometrisinin ve etiketlerinin gizlenecegi
bolgeler tanimlamay:i saglar.

Alignment Properties
diyalog kutusu >
Masking sekmesi

Offset Alignment

Ana guizergaha dinamik olarak bagli olan Offset
glizergahlar olusturmayi saglar.

Ribbon: Home
sekmesi » Create
Design paneli >
Alignment > Create
Offset Alignment
komutu

E="
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Widening

Belirlenen kilometre veya geometrik yerlerde
(otobiis duraklari ve donlsler gibi) kuralli ve

paralel olmayan genislemeler olusturmayi saglar.

Ribbon: Home
sekmesi > Create
Design paneli >
Alignment » Create
Widening komutu

2

Dinamik Offset veya
Curb Return’leri statik
hale getirme

Offset glizergahlar bir ana glizergaha, Curb
Return glizerghahlar iki ana glizergaha baghdir.
Bu glizergahlar ana glizergahlara dinamik bagh
olarak hareket ederler. Manuel diizenleme
yapmak gerekirse statik hale donusturilebilirler.

Alignment Properties
diyalog kutusu,
Offset Parameters /
Curb Returns
sekmesi, Update
Mode ayari

3 API

Ozellik

Aciklama

Civil nesneleri icin
.NET API

Glzergahlar, stiller, ayarlar, profiller ve boru sebekeleri icin .NET API saglar.
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4 Koridor

Ozellik

Aciklama

Yerlesim

Section Editor

Koridor kesit editort komutlarini ribbonda
goruntuler.

Ribbon: Corridor
context sekmesi »
Modify paneli >
Corridor Section Editor
komutu

) 4

Koridor kesitlerinden
geometrik
override’lari kaldirma

Enkesitlere uygulanan override’lari kaldirmak
icin gelistirilmis bir yontem saglar.

View/Edit Corridor section araglarinin
Parameter Editor kisminda yer alan Assembly
Collection seviyesine ilgili check kutusu
eklenmistir. Override yapilmissa bu kutu
isaretli gdzuikiir. isareti kaldirarak tim
override’lari iptal edebilirsiniz.

Section Editor t
sekmesi » Corridor
Edit Tools paneli »
Parameter Editor
komutu

Assembly Collection
seviyesinde override
kontrolu

Select region butonu

Corridor Properties diyalog kutusunun
Parameters sekmesinde, region’i cizimde
secerek diyalog kutusunda aktif olmasini
saglayan bir buton yer alir.

Corridor Properties
diyalog kutusu,
Parameters sekmesi,
Select Region From
Drawing butonu

Baseline ve region’lar
icin isimlendirme
sablonu

Yeni koridor baseline’lari ve region’lari igin
isimlendirme sablonu saglar.

Corridor Properties
diyalog kutusu,
Parameters sekmesi.

Yeni bir baseline veya
region olustururken,
Name Template diyalog
kutusuna
ulasabilirsiniz.

Edit Region

Edit Region komutu Corridor Properties
diyalog kutusunu agmayi ve diyalog kutusunda
cizimde secilen region’i aktif hale getirmeyi
saglar.

Ribbon: Corridor
context sekmesi »
Modify paneli > Edit
Region komutu

Isolate/Show Region

Isolate Region komutu koridorda diger tim
region’lari kapal hale getirmeyi saglar.
Boylece, sadece istenen region ekranda

Ribbon: Corridor
context sekmesi >
Modify paneli > Isolate
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gorindr.

Show All Regions komutu kapatiimis olan
region’lari yeniden gorlinttlemeyi saglar.

Region komutu
i

Ribbon: Corridor
context sekmesi >

Modify paneli > Show
All Regions komutu

B

Kalici hedefler

Corridor Properties diyalog kutusunun
Parameters sekmesinde tip kesitleri
degistirirken hedeflerin kalici olmasini saglar.

Corridor Properties
diyalog kutusu,
Parameters sekmesi.

Highlighting

Yeni Region Highlight Settings ile Corridor
Properties diyalog kutusunda koridor
parametrelerini diizenlerken baseline’larin ve
region’larin highlight olup olmayacagi
ayarlanir.

Toolspace Settings
sekmesi > Corridor
basligi tizerinde sag tus
» Edit Feature Settings

Zoom to ve Pan to
region

Corridor Properties diyalog kutusundan
koridor region’larina zoom ve pan yapmayi
saglar.

Corridor Properties
diyalog kutusu,
Parameters sekmesi.

Birden fazla baseline’i
olan koridorlar igin
otomatik sinir

Birden fazla baseline’i olan koridorlarda,
koridorun tamami boyunca sinir olusturmak
icin otomatik bir yéntem saglar.

Corridor Properties
diyalog kutusu,
Boundaries sekmesi.

Diyalog kutusunda
koridor ismi tizerinde
sag tus » Corridor
Extents As Outer
Boundary

Not Koridorda birden
fazla baseline
oldugunda komut
mentde gelir.

Koridor sinirindan
2 boyutlu polygon
olusturma

Koridorun sinirlari etrafinda kapali polygon
olusturmak icin yeni bir komut saglar. Koridor
ylzeyini olusturmak ve kazi sinirlarini gérmek
icin isinize yarayabilir.

Ribbon: Home sekmesi
» Create Design paneli
» Create Boundary

From Corridor komutu
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5 Hidroloji

Ozellik

Aciklama

Yerlesim

Hydraflow
Extensions’t agma

AutoCAD Civil 3D’de direkt ribbondan
Hydraflow Extensions’i agmayi saglar. Bu
programlar AutoCAD Civil 3D kurulumu
sirasinda istege bagli olarak kurulur.

Ug Hydraflow eklentisi icin masaiistiinde
kisayollari olusmaz. Bu eklentiler artik AutoCAD
Civil 3D’nin icinden acilr.

Ribbon: Analyze
sekmesi > Design
paneli > Launch Storm
Sewers

®

Launch Hydrographs

[

Launch Express

b

Metrik birim destegi

Express, Hydrographs ve Storm Sewers
uygulamalari icin metrik birim destegi saglar.

Hydraflow drtnlerinde
birimler arasi gecis
yapmayi saglayan yeni
Units butonu

Metrik parca ebatlari

Metrik parga ebatlari saglar.

6 Uyumluluk

Ozellik

Aciklama

Yerlesim

Revit bina modelinin
import edilmesi

Autodesk Revit’in bina modelini import etmeyi
ve model tizerine, belirlenen birim ve
koordinat sistemini kullanarak, oturtmayi
saglar.

Ribbon: Insert
sekmesi » Import
paneli > Import
Building Site
komutu

&9

Prospector'da Autodesk
Revit bina modelinin
gorlintiilenmesi

Bina modelinin 6zelliklerini Prospector
agacinda Building Sites altinda gosterir.

Building Site'in altindan Doors, Floors, Roofs
ve Utilities kisimlarina ulasihr.

Burada her parca listelenir.

Toolspace
Prospector sekmesi

Autodesk Revit bina

Bina nesnesinin isim, agiklama, stil, cagiriima

Ribbon: View
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modeli icin Properties
paleti destegi

noktasi X,Y,Z ve aci bilgilerine AutoCAD
Properties paletinden ulasabilirsiniz.

sekmesi > Palettes
paneli > Properties
komutu

&

Autodesk Revit bina
modeli icin grip nokta
destegi

Bina modelinin cagirilma noktasi ve utility
baglanti noktalari icin grip noktalari gelir.

7 Kavsak

Ozellik

Aciklama

Yerlesim

Create Intersection
sihirbazi

Yeni Create Intersection sihirbazi kavsak
tasarimi yapmayi hizlandirir.

Ribbon: Home
sekmesi > Create
Design paneli »
Intersection komutu

=l
Tl

Kesisimi segmeniz
istendiginde, birbirini
kesen iki glizergahin
kesisim noktasini
tutmak icin Osnap
kullanmaya dikkat
edin.

Intersection grading

iki tip kavsak baglanti secenegi sunar:

o Birincil yolun tst noktasini kullanir, tali
yol bu yola adapte olur.
o ki orta aksin iist noktalarini kullanir.

Ribbon: Home
sekmesi > Create
Design paneli »
Intersection komut

el
I

Intersection
koridorlari

Intersection koridorlarini ve intersection
nesnesine dayali koridor region’larini bir tip kesit
seti kullanarak pratik bir sekilde olusturmayi

Ribbon: Home
sekmesi » Create
Design paneli >

saglar. Intersection komutu
Intersection nesnesi olustuktan sonra koridor i: 2
region’lari dinamik olarak gtincellenir.

Intersection profilinin Intersection’da ikincil yola (tali yol) ait olan Ribbon: Home

kilitlenmesi

kirmizi hat profilinin kotlarinin birincil yolun

sekmesi » Create
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(ana yol) kotlarina kilitlenmesini saglar.

Design paneli >
Intersection komutu

|

I
8 Etiket
Ozellik Aciklama Yerlesim
Egri etiketi Egri cizgisini maskelemek icin Properties Egri etiketi Uizerinde
maskeleme paletinde secenek sunar. sag tus » Properties.

Properties paletinde,
Design sekmesinde,
Labels altinda Masking
» Contour Line Only
secenegi

Profil ve kesit
etiketleriyle ilgili
gelismeler

Yogun grafik goriinimlerinde profil ve kesit
etiketlerinin Ust Uiste binmesini engelleme ile
ilgili secenekler sunar.

Kaydirilabilen profil etiketleri egimin degistigi
noktalar, ana ve ara kilometreler ve yatay
glizergah noktalarina atanan etiketlerdir (Grade
Break, Major/Minor Station ve Horizontal
Geometry Point).

Kaydirilabilen kesit etiketleri ana ve ara
mesafeler ve egimin degistigi noktalara atanan
etiketlerdir (Major/Minor Offset ve Grade
Break).

Ribbon: Annotate
sekmesi > Labels &
Sekmeles paneli > Add
Labels » Profile View
» Add Profile View
Labels komutu

Bant etiketi ile ilgili
gelismeler

Profil ve kesit bant etiketleri artik etiket
nesneleri olarak gecer.

Bant etiketlerini secebilir, strtikleyebilir ve
diger etiket nesneleri gibi grip noktalarindan
midahale edebilirsiniz. Ust iiste binmeleri
engellemek icin bant etiketleri stagger
secenekleri ile kaydirilabilir.

Profile View Properties
» Bands sekmesi

Etiket cizgisi ile ilgili
gelismeler

Etiket cizgisine kose ekleme, etiket cizgisinin ug
kisminda yer alan kuyruk ¢izgisini gizleme ve
etiket grip noktasini ilk haline donusttirme gibi
diizenlemeler yapilabilir.

Etiket ¢cizgisinin grip
noktalarindan
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Ana ve ara araliklar Profil ve kesit bant setleri, ve profil ve kesit Profile View Properties

gortiniimleri icin ana ve ara aralik secenekleri » Bands sekmesi
sunar.
9 LandXML
Ozellik Agiklama Yerlesim
LandXML versiyon LandXML verisi olarak export ederken hangi Export To LandXML
destegi LandXML versiyonun (1.0, 1.1 veya 1.2) diyalog kutusu

kullanilacag belirlenebilir.

Boru sebekesi import Storm Sewers uygulamasindan boru sebekesi LandXML Settings
ayarlari import ederken ayar yapmayi saglar. diyalog kutusu,
Import sekmesi

10 Nesne Aktarma

Ozellik Agiklama Yerlesim

Plandaki nesneleri profil Plan bakisinda goziiken bir nesneyi nesnenin Ribbon: Home

ve kesit gériiniimlerine yerlesimini géstermek icin profil veya kesit sekmesi » Profile &

aktarma gortinimiinde ¢izmeyi saglar. Section Views paneli
» Profile View »

Aktarilan nesne kaynak nesne ile dinamik
Project Object To

baglantisini korur ve kaynakta yapilan tiim
Profile View komutu

degisiklikleri yansitir.

Ribbon: Home
sekmesi » Profile &
Section Views paneli
» Section View »
Project Object To
Section View
komutu

(s

Aktarilan nesneleri Profil ve kesit gértinimlerinde aktarilan
grip’lerle duzenleme nesneyi grip noktalari ile diizenlemeyi saglar.
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Aktarilan nesneleri
etiketleme

Profil ve kesit gériintimlerinde aktarilan
nesneleri etiketlemeyi saglar. Profile View ve
Section View etiket stillerinde yer alan
Projection etiket stilleri ile etiketler
diizenlenir.

Ribbon: Annotate
sekmesi > Add
Labels » Add
Projected Object
Label komutu

Properties paletinde
nesne 6zelliklerinin
goruintilenmesi

Aktarilan nesnelerin 6zellikleri AutoCAD’in
Properties paletinde gortintilenir.

Ribbon: View
sekmesi » Palettes
paneli > Properties

—

11 Parsel

Ozellik Aciklama Yerlesim
Parcel Slide Line ve Parsel yerlesimini 6n cephenin uzantisindan minimum Ribbon: Home
Swing Line yerlesim offset degerini, ve/veya minimum genislik ve derinligi sekmesi »

ve diizenleme
komutlar

belirleyerek kontrol etmeyi saglar.

Bazi parametreler (alan ve 6n cephenin uzantisi gibi)
parsel 6lcustyle ilgili komutlar sirasinda girilir. Bdylece,
Parcel Layout Tools diyalog kutusu bu komutlar
secildiginde genisler.

Diyalog kutusunda ayar secenekleri icin grafikler gelir.

Create Design
paneli > Parcel
» Parcel
Creation Tools
komutu

Gizimde grafik Seceneklerin etkilerini ve parsel yerlesimini yaparken Toolsapce
onizleme belirlediginiz degerleri gdrmeniz i¢in ¢izimde gecici Settings
grafikler gelir. sekmesi »

Parcel »
Commands >
CreateParcelByL
ayout

Side Angle & Side Angle ve Slide Direction olusturma komutlari Slide Ribbon: Home

Direction komut Line — Create komutu ile tek bir komut altinda sekmesi >

birlesimi

birlesmistir.

Side Angle ve Slide Direction diizenleme komutlari Slide
Line - Edit komutu ile tek bir komut altinda birlesmistir.

Create Design
paneli > Parcel
> Parcel
Creation Tools
komutu
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12 Boru Sebekesi

Ozellik

Aciklama

Yerlesim

Birden fazla boru
sebekesi destegi

Storm Sewers'dan birden fazla boru
sebekesi import edilebilir.

Ribbon: Insert sekmesi > Import
paneli > Storm Sewers

£3)

Import sirasinda
parca eslestirme

Storm Sewers verisi AutoCAD Civil
3D’ye import edilirken yeni parca
eslestirme 6zelligi saglar. Import
sirasinda, boru sebekelerinin tek
tanimlayicisi olarak parca isimleri
kullanilir.

Import sirasinda, bir ¢izgi veya
inlet/junction’in ismi yoksa, pipe
network feature settings kismindaki
isimlendirme sablon ayarina gére
isimlendirilir.

Import sirasinda, AutoCAD Civil 3D
parca listesi ile tam eslesmeyen bir

parca ebati oldugunda, ona en yakin
ebatlardan buytik olani kullanilir.

Toolspace Settings sekmesi >
Pipe Network » Commands »
ImportStormSewersData, Storm
Sewers Migration Defaults
ayarlar

Storm Sewers’a
boru sebesini
export etme

Storm Sewers’a boru sebekelerini
export etmeyi saglar. Boylece boru
sebekeleri icin analiz yapilabilir.

Ribbon: Output sekmesi > Export
paneli > Export to Storm Sewers
komutu

@

Tum katalog
parcalari ile parca
listeleri

AutoCAD Civil 3D'de yer alan tiim
parcalari iceren bir parca listesi
olusturmayi saglar.

AutoCAD Civil 3D ve Storm Sewers
uygulamasi arasinda aktarma
yaplyorsaniz, bu yeni komut isinize
yarayabilir.

Ribbon: Home sekmesi » Create
Design paneli > Create Full Parts
List komutu

LandXML Import
ayarlari

Mevcut LandXML Settings diyalog
kutusunda Pipe Network Import
Settings yer alir. Bu secenek Storm

Sewers uygulamasindan boru sebekesi
verisinin import islemi ile ilgili destek

saglar.

Toolspace Settings sekmesi >
¢izim ismi Uzerinde sag tus > Edit
LandXML Settings secenegi

AutoCAD Civil 3D 2010 Yeni Ozellikler ve Ayarlar
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Hidrolik Egim
Hatlari ve Enerji

Profil gériinimlerinde boru ve bacalar
icin hidrolik egim ¢izgisini (HGL) ve

Pipe Properties diyalog kutusu »
Part Properties sekmesi,

Egim Hatlar enerji egim cizgisini (EGL) gbstermeyi Geometry degerleri

ve etiketlemeyi saglar. Structure Properties diyalog

Pipe Properties diyalog kutusunda ve kutusu > Part Properties sekmesi,

Structure Properties diyalog kutusunda Geometry degerleri

Part Properties sekmelerinde HGL ve

EGL icin bolumler yer alir.
HGL/EGL HGL ve EGL bilesenleri icin boru ve Pipe Style diyalog kutusu »
bilesenlerinin profil baca stili diyalog kutularinda Display sekmesi » Profile View
goriinimiinde gosterimleri ile ilgili secenekler yer alir. Direction, Hydraulic Grade Line
gosterilmesi Profil gértinimiinde hidrolik egim ve Enegy Grade Line bilesenleri

cizgisini ve enerji egim cizgisini
gostermek icin boru ve baca stillerinde
gortnumleri ile ilgili ayarlar
acmalisiniz.

Structure Style diyalog kutusu »
Display sekmesi > Profile View
Direction, Hydraulic Grade Line
ve Enegy Grade Line bilesenleri

HGL/EGL etiketleri

Profil gériintimlerinde boru ve bacalar
icin hidrolik ve enerji egim cizgilerini
etiketlemeyi saglar.

Borular icin asagidaki yeni etiket
ozellikleri gelmistir:

Hydraulic Grade Line Up
Hydraulic Grade Line Down
Energy Grade Line Up

O O O O

Energy Grade Line Down

Bacalar icin asagidaki yeni etiket
ozellikleri gelmistir:

o Hydraulic Grade Line
o Energy Grade Line

Boru ve baca etiket stilleri

Yeni Pipe Network
Parts Catalog

icerigi

Boru sebekesi parca kataloguna yeni
parca tipleri eklenmistir:

Circular pipes

o Corrugated Metal Pipe

o HDPE Pipe

o Corrugated HDPE Pipe
Elliptical pipes

o Concrete Horizontal Elliptical
Arch Pipe

Toolspace Settings sekmesi >
Pipe Network » Parts List > Add
Part Family secenegi
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Structures (Inlet\Outlet)

o Concrete Flared End Section
Concrete Rectangular Winged
Headwall

o CMP Rectangular End Section

Bu yeni parca tiplerine ek olarak,
mevcutlara yeni ebatlar eklenmistir.

13 Profil

Ozellik Aciklama Yerlesim

Profil tarama Birden fazla profil iceren profil gériintimlerine Create Profile View
tarama deseni eklemeyi saglar. Tarama desenleri sihirbazi, Profile View
profilde kazi, dolgu, birden fazla sinir ve metraj Properties diyalog
gostermek icin kullanilabilir. kutusu

Her tarama alani igin hangi tarama deseninin
kullanilacagini tanimlayan bir Shape Style

belirlenebilir.
14 Metraj
Ozellik Agiklama Yerlesim
Quantity Takeoff Metraj isleri icin merkezi bir yer saglar. Ribbon: Analyze sekmesi »
panorama vista Ana 6deme listeleri agip ¢izim nesnelerine (kQTO paneli > QTO Manager
omutu

veya kapali alanlara 6deme miktarlari
atayabilirsiniz. a4

Cizimde 6deme listesi atanmis olan
nesneleri veya daha 6deme listesi
atanmamis olan nesneleri highliht
yapabilirsiniz.

Raporlar Cizimde atanmis olan 6deme Ribbon: Analyze sekmesi »
miktarlarinin 6zet tasima hesaplarini QTO paneli » Takeoff komutu
yapmak icin raporlar sunar.

Odeme Nesnelere veya kapali alanlara 6deme ile AssignPayltem komutu
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miktarlarinin ilgili kodlarin manuel olarak atanmasini AssignPayltemToArea komutu
manuel olarak saglar.
atanmasi
Odeme Koridor modelinin feature line ve Corridor Properties diyalog
miktarlarinin alanlarina, ve boru sebekelerine 6deme ile kutusu, Codes sekmesi
otomatik atanmasi ilgili kodlarin otomatik olarak atanmasini Network Parts List diyalog
saglar. kutusu
15 Arazi Modeli
Ozellik Aciklama Yerlesim
Sinirlar Import edilen TIN, LandXML, grid veya koridor Ribbon: Surface
kirpma ylzeylerine sinirlari kirpma islemi uygulanabilir. context sekmesi >
Modify paneli > Add
Data » Boundaries
komutu
Y
Egri Bir arazi modelinde kullanilan egrileri gizime polyline’lar o Toolspace
verisinden olarak getirmeyi saglar. Prospector
AutoCAD Eger polyline egri verisi olarak eklenmisse, Insert To sekmesinde,
polyline’lan Drawing komutu ¢alistirildiginda bir veya daha fazla arazi modeli
elde etme AutoCAD polyline’i cizime eklenir. Ek olarak, egrilerle tamiminda
ilgili kayit (arazi modeli islem listesinde) koordinat Contour
listesinden yeni polyline’lara dénusdar. ba§.llg|n|
segince
Prospector’in
alt kismindaki
liste
gorinimd
gelir.

o Listedeki
egrilerden
birinde sag tus
yapip Insert
To Drawing
deyin.

Yeni komut o SurfaceExportToDEM komut ayari: Null- Toolspace Settings
ve ozellik elevation ve grid spacing. sekmesi > Surface
o AddSurfaceBreaklines/AddSurfaceContours basligl > Commands
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ayarlari

komut ayarlari: Weeding ve supplementing
factors ve mid-ordinate distance.
Rebuild Surface 6zellik ayari: Surface Defaults

bashgi > komut ismi
uzerinde sag tus > Edit
Command settings

kisminda arazi modelinin otomatik secenegi
glincellenmesi ile ilgili ayar.

16 Survey

Ozellik Aciklama Yerlesim

Import survey data
sihirbazi

Bir field book dosyasinin, LandXML dosyasinin,
nokta dosyasinin veya ¢izimdeki noktalarin
survey veritabanina import edilmesi ile ilgili
sihirbaz gelir.

Ribbon: Home sekmesi
» Create Ground Data
paneli » Import Survey
Data komutu

=

Linework kod setleri

Field book dosyasinin, LandXML dosyasinin,
nokta dosyasinin veya cizimdeki noktalarin
import edilmesi icin kullanibilecek bir linework
kod seti tanimlamayi saglar.

Linework kod setleri Toolspace Survey
sekmesinde Linework Code Sets baslig altinda
gruplanir.

Toolspace Survey
sekmesi > Linework
Code Sets Uizerinde sag
tus > New secenegi

Field Book dosyasinin
import edilmesi

Field book dosyasini import etmeyi saglar.

Survey noktalari ve ¢izgi 6zellikleri cizime ve
survey veritabanina eklenir.

Ribbon: Home sekmesi
» Create Ground Data
paneli > Import Survey
Data komutu

=

ASCII nokta
dosyasinin import
edilmesi

X-koordinati, Y-koordinati, Z-koordinati ve
Aciklama iceren bir ASCII nokta dosyasini
import etmeyi saglar.

ASCII nokta dosyasini import etmek icin, nokta
dosya formati gibi bilgiler belirlenir. Survey
noktalari ve ¢izgi 6zellikleri ¢izime ve survey
veritabanina eklenir.

Ribbon: Home sekmesi
» Create Ground Data
paneli > Import Survey
Data komutu

=

Gizimdeki noktalarin
import edilmesi

Aktif cizimde yer alan noktalarin survey
veritabanina ve agina import edilmesini saglar.

Toolspace Survey
sekmesi > Survey
Dasekmeases »
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database ismi >
Networks » network
ismi Uzerinde sag tus »
Import > Import
Points From Drawing
secenegi

LandXML'in import LandXML dosyasini import etmeyi saglar. Toolspace Survey

edilmesi sekmesi > Survey
Databases » database
ismi » Import »
Import Field Book
secenegi

Database altinda Field book veya ASCII dosyasini import ettikten Toolspace Survey

Import Events bashg| sonra verinin giincellenmesini saglar. sekmesi > Survey

Import islemi tamamlandiktan sonra, nokta
aciklamalarini diizenleyebilir ve veriyi yeniden
isleyebilirsiniz.

Bu islemi hatalar minumum seviyeye indirelene
kadar tekrarlayabilirsiniz.

Databases » database
ismi » Import Events
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